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INTRODUCTION
About This Program

Life Meets Work: Overcoming Stress, Fear and Anxiety was developed to provide employees
with the tools necessary to cope with the many feelings that are inspired by everyday
workplace stressors as well as a sudden crisis or tragedy. This program explains the
various reactions that may occur and recommends specific behaviors to help overcome
tension, anxiety and the feelings of helplessness. These crucial coping skills can help the
viewer to create more positive outcomes in the face of stress and adversity, resulting in
improved mental attitudes and productivity.

This Leader’s Guide is designed to help you conduct a thorough training session on

Life Meets Work: Overcoming Stress, Fear and Anxiety. It permits you to use this program in
many different ways, giving you the flexibility to determine which training format is best for
your organization’s needs. The video is approximately |7 minutes long and can be stopped
easily for discussion of important points.

The PowerPoint® information in the Leader’s Guide will assist you in the presentation of
this material. You may copy the exercises, Pre-Test, Post-Test and Evaluation Form in the
Leader’s Guide when you use them in conjunction with the video. lllustrated employee
handouts are also available for use with this program. These handouts include a quiz and
should be given to participants as a helpful tool for future reference.

We recommend that you tailor the program to your organization’s needs by including any
relevant information unique to your employees. The specifics of how you structure the
training session are up to you.

Training Materials
You will need:
U A training room located away from major distractions or interruption

U A comfortable arrangement of chairs and tables, preferably in a circular pattern,
with an opening for a TV monitor and other visual aids (Be certain all participants
can see the viewing screen and each other)

U Adequate lighting that can be adjusted while viewing the video

U A location, possibly including a podium and/or flipchart, from which the
trainer/speaker can lead discussion

U The training video Life Meets Work: Overcoming Stress, Fear and Anxiety
U TV/VCR with remote

U Copies of the class agenda (see page 3)

U Paper and pencil for each participant

U A flipchart or dry-erase board and appropriate markers

U A computer with PowerPoint® software and a projector to show the PowerPoint®
Presentation

U Copies of the Post-Test (page 9) and Evaluation (page | 1)
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Preparation
Preparation is the key to effective training.There are several things you need to do prior
to the session:

Invite Participants

Send out letters or memos to participants or post a notice two weeks in advance of the
training date. (Sample is included on page 4.) State the location, date and time, and meeting
agenda. Administer the Pre-Test in advance.

Establish Training Objectives
Suggested training objectives for this presentation are defined for you below:

* To understand that stress, fear and anxiety are a normal part of everyday life
* To learn practical techniques to manage stress, fear and anxiety

* To understand common reactions to crisis and tragedy

* To realize the impact of stress or crisis on life at work

* To appreciate the benefits of managing stress or surviving crisis.

Feel free to edit the training objectives to meet the particular needs of your organization.
Training objectives should coincide with the content of the video.

Determine the training objectives in advance so that you can identify the approach to take
for the training session. It is also important to decide what level of proficiency is expected
from participants upon completion of the training.

Determine the Audience

Another aspect to consider in planning this training session is the audience.Tailor your
presentation to the skills or experience of your participants. The focus of your discussion
and the depth of content presented may vary, depending on whether you are providing an
orientation for new managers or a refresher course for experienced managers.

The group size should range from 10 to 20 people. Most of the exercises in this program
require that the group break into two smaller groups in order to increase participation.

When the group is too large, individual attention may be lost.

2-Hour Session Agenda (using video-specific discussion issues)

INtrOdUCLION .. I5 minutes
Video and DiSCUSSION ......ooeveeeeeeciieeeceeeeeeeeeneanas 40 minutes
EXEIrCiSE | et 20 minutes
EXEICISE 3ttt esneas 20 minutes
COoNCIUSION et 25 minutes

3-Hour Session Agenda (using video-specific discussion issues)

INErOdUCLION .. I5 minutes
Video and DiSCUSSION ......oeeueeeeeeeieeeeeeeeeeeeeeneana 40 minutes
EXErCiSe | oo 20 minutes
EXEICISE 2 vttt sesesenens 40 minutes
Break ...t 20 minutes
EXEIrCiSE@ 3 ettt 20 minutes
CONCIUSION .t 25 minutes
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Sample Of Invitation Memo

Date: December 3,2004

To: All Managers

From: Monica Gilbert, Human Resource Manager

Re: Life Meets Work: Overcoming Stress, Fear and Anxiety

You are invited to attend an important training session later this month. Life Meets Work:
Overcoming Stress, Fear and Anxiety will explore our reactions to the stressors and crises
that occur in our lives and identify ways to manage our reactions. This training will help
you to cope more effectively with stress and trauma and improve your well-being and
productivity.

Please plan to attend the training session on December 10,2004, at 2:00 p.m. We will be
meeting in the main conference room for a two-hour session. If you are unable to attend,
please contact me at 555-8890 as soon as possible.

Our goals for the training session are:

* To understand that stress, fear and anxiety are a normal part of everyday life
* To learn practical techniques to manage stress, fear and anxiety

* To understand common reactions to crisis and tragedy

* To realize the impact of stress or crisis on life at work

* To appreciate the benefits of managing stress or surviving crisis.

Agenda:

¢ Introduction 2:00 - 2:15

* Video and Discussion 2:15 - 2:55
 Exercise | 2:55 - 3:15

* Exercise 3 3:15 - 3:35

* Conclusion 3:35 - 4:00

We look forward to seeing you on December 10, 2004.
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Presentation Tips

Overcoming anxiety

The best way to overcome anxiety about speaking before a group is to be prepared.
Although it’s natural to feel nervous, your sweaty palms will disappear once you focus
on what you are saying. Concentrate on communicating your message and your
presentation will flow naturally.

Choosing your vocabulary
Don’t lose your audience by using overly complex words or phrases. It’s best to use the
same comfortable language that you would use when speaking to participants one on one.

Getting rid of the “umms”

One of the most annoying mistakes a speaker makes is saying “umm” every time there is

a break between thoughts. Remain silent while you think about what you're going to say
next.The silence will seem longer to you than it will to the audience. If you remember this,
you'll feel less pressure to fill the silence.You can control your “umms” by jotting down
notes beforehand. If you want to include personal anecdotes or examples, write down a
few notes to trigger your memory. Beware of writing down too much, however.You’ll
deliver your message to your note cards instead of your audience.

Controlling the speed and tone of your voice

You'll put your audience to sieep if you speak too slowly, and they won’t be able to keep
up with the content if you speak too quickly. Approximately 150 words per minute is the
best speed (that’s about two thirds of a page, typed, double-spaced). Vary your tone often,
especially when making an important point. Adding emotion to your presentation will keep
your audience involved. Again, strive for a conversational tone.

Sticking to the schedule
Begin class on time and restart the session promptly at the end of the break. Except for
emergencies, participants should not be interrupted for messages.

Asking for questions

Ask for questions throughout the session. Be prepared to answer all types of questions,
but don’t be worried you don’t know every answer.You can simply say, “Let me find out
for you and get back to you.” Keep in mind many questions are best answered through
discussion. An appropriate response might be,”Good question. Let’s hear some discussion
on that one.” Watch the clock, though.Too many unplanned discussions can eat up

your time.
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TRAINING SESSION OVERVIEW
Giving The Pre-Test

It is recommended that you send the Pre-Test (located on page 16) along with the
Invitation before the training session. That allows you to review participants’ answers and
get an idea of what they already know. Otherwise, administer the Pre-Test at the start of
the session, and review during the break.

Presentation Outline

Open the session.Welcome the participants and introduce yourself to the group.

Give a brief explanation of the purpose of the session and quickly review the agenda.
Have participants introduce themselves and state the department or area in which they
work. You may want to use an “ice breaker” to get the class warmed up for group
discussion and to get to know each other.

Distribute and review copies of the training objectives for this session. Be sure

participants understand what you expect them to learn and what skills they need to display
as a result of this training. Knowing what is expected in advance better prepares the
employees and helps them to participate successfully.

Objectives for this training session are:

* To understand that stress, fear and anxiety are a normal part of everyday life
* To learn practical techniques to manage stress, fear and anxiety

* To understand common reactions to crisis and tragedy

* To realize the impact of stress or crisis on life at work

* To appreciate the benefits of managing stress or surviving crisis.

Start the video. To avoid unpleasant surprises, it’s a good idea to pre-set the volume of
your monitor before the training session begins.

Two discussion guides have been developed for this program.“Scene-Specific Discussion
Issues” is designed to be used if you choose to stop the video for discussion after each
scene. “Discussion Topics” is designed to be used after watching the video in its entirety.
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EXERCISES

Exercise #1
PAIR AND SHARE

Have the group divide into pairs. Ask each pair to take turns sharing a stressful situation
that is occurring in their lives right now. The person not sharing the stressful situation
should ask questions to find out what, if any, steps are being taken to manage the stress
and make recommendations based on the video about ways that the stress might be better
controlled. After 10 minutes, ask for volunteers to share examples of helpful ideas or
information that they will be able to apply as a result of the session.

Exercise #2
GROUP DISCUSSION

Ask the group to recall the events of 9/11/0l. This dramatic event was a crisis of global
proportions that remains vivid in our memories. Ask the following questions to lead the
discussion:

What were your initial physical reactions to the news?

How did you feel during the days and weeks following this event?

Did you do anything differently in your daily routine?

What did you do to cope with your feelings of stress, fear and anxiety?
After viewing this video is there anything that you would do differently now?

Exercise #3
BRAINSTORM

Divide the group in smaller groups of four or five. Provide each group with a flip chart and
a marker. Ask each group to brainstorm as many effective and creative ways as possible to
combat workplace stress. After |5 minutes of brainstorming have each group choose the
five best ideas and share them with the entire group.
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SESSION SUMMARY

Summarize

One summarizing technique is to review the course objectives with the class. Another
technique is to ask each participant to highlight what was learned from the training
session. Ask the participants if they have any final questions.

Administer The Post-Test

Distribute copies of the Post-Test (located on page 9) to each participant.You may

wish to customize the Post-Test to fit your organizational objectives. The Post-Test is

an excellent tool for determining how much each participant learned during the session.
Compare the results to the Pre-Test and review the different answers.

Evaluate

Distribute the Course Evaluation form (located on page | |) to participants when they
have finished answering the questions on the Post-Test. VWhen each participant returns the
Course Evaluation form to you, thank him or her for attending the session.
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PRE-TEST/POST-TEST

I. True False When something traumatic happens, we should work to control our
feelings in order to regain control of our lives.

2. True False Self-medication helps to overcome stress and fear.

3. True False Forgetfulness is a common reaction to crisis or tragedy.

4. True False Regular exercise can reduce stress and anxiety.

5. True False Most people have a very similar reaction to stress and trauma.

6. True False An increase in appetite is a very unusual reaction to stressful events.
7. True False One way to effectively manage stress and fear is to maintain your

social activities.

8. True False Anxiety and apprehension can be contagious.
9. True False It’s easy to fall back into bad habits during stressful times.
10. True False There are no positive outcomes of a crisis or tragic events.
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PRE-TEST/POST-TEST ANSWERS

2.

9.

True

False

True

True

False

False

True

True

True

10. False

Self-medication can be dangerous and does nothing to overcome stress
and fear.

The form, timing and intensity of reactions to stress and trauma can be very
different for each person.

An increase in appetite is one of the many possible reactions to stressful events.

Living through crisis and tragedy often brings unexpected benefits.
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COURSE EVALUATION

Your input is IMPORTANT in helping us evaluate and improve our training programs. Thank you for taking
time to think about and respond to the following questions:

Course Date: Facilitator:
About the Course
|. Were the objectives of the course clearly stated? YES NO

2. How well were the objectives met by the course?!
Were not met I 2 3 4 5 Were met very well

3. How applicable will this training be to your job?
Almost none of the material will be applicable to my job.
Some will be applicable, but some was confusing or irrelevant.
Absolutely applicable! | look forward to seeing results soon!

4. Was the information presented in a logical and understandable order?
Didn’t seem logical at all.
Some was, some wasn'’t.
Yes, all of it seemed logical and understandable.

5. How useful were the discussions, the self-assessment tool, and the exercise in helping you learn the
information?

Not useful at all Somewhat useful Very useful

6.To what extent did this training meet your expectations?
DID NOT MEET my expectations MET expectations EXCEEDED expectations

7.What would you add or change to improve this course!?

About the Facilitator

8. Was the facilitator positive and professional? Very much so Could improve

9. How well was the facilitator prepared and able to explain the information?
NOT well prepared | 2 3 4 5 VERY well prepared

10. Did the facilitator create an atmosphere that encouraged questions and learning?
Yes No — Facilitator should have:

I'l. Did the facilitator explain the material in ways that made it applicable to your job?
Very much so Sometimes Almost none was connected to my job

12. Your comments on the facilitator:
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POWERPOINT® PRESENTATION OVERVIEW
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POWERPOINT® PRESENTATION OVERVIEW CONTINUED
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CUSTOMIZING A POWERPOINT® PRESENTATION

The PowerPoint® presentations included on the Coastal DVD and CD products are
customizable when used on a computer loaded with Microsoft PowerPoint® software.
(Note: In the following instructions, “click” implies a click with your left mouse button. If a
“right” click is necessary, it will be so indicated.) Microsoft PowerPoint® has many features.
The following steps will help you customize our presentations quickly. To customize a
presentation:

I. If the “Customizable Version” icon is displayed on the landing screen, click on this
option. If this option is not available, click on the PowerPoint® presentation to open it.
Save this presentation to another location, such as your hard drive or a folder on the
network. You will make your customizations on the saved version.

To add, copy, hide or remove a slide, or to change the order of the slides in
the presentation:

2. Click on “View” on the menu bar.

3. Click on “Slide Sorter” from the “View” menu. Or, under the “Normal” view, you may
use the “Outline” on the left side of the screen.

4. To add a slide, place your cursor in front of the slide where you want to add a slide.
Click on “Insert” on the menu bar. Then, click on “New Slide” on the “Insert” menu.
Or, click on the “New Slide” tool on the tool bar. Choose a slide format to fit your
desired content, and follow the prompts given.

5. Sometimes it’s easier to copy a slide, and then change the content of the slide than to
create a new one. To copy a slide, click on the original slide. Click on “Edit” on the
menu bar, and choose “Duplicate.” A new copy will be created to the right of the
original slide. Or, click on “Edit” on your menu bar, and choose “Copy.” You may then
“Paste” the slide wherever you want it to appear.

6. To hide a slide from your presentation, but to keep it for future use, right click on the
slide you wish to hide, and choose “Hide Slide” from the menu. Or, click on the “Hide
Slide” tool on the tool bar.

7. To remove a slide from the presentation, click on the slide you want to remove. Click
on “Edit” on the menu bar. Then, click on “Delete Slide” on the “Edit” menu. Or, click
on the slide, and press the “Delete” key on your keyboard.

8. To change the order of the slides in the presentation, click on the slide to be moved
and while holding the mouse button depressed, drag the slide to its new location.
Release your mouse button to place the slide.
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If you wish to change or remove the animation effect as you move from slide
to slide:

I. Double click on the slide you want to change the animated transition on.

2. Double click on the text box of the slide. A border and white handles appear around
the text box.

3. Click on “Slide Show” on the menu bar. Then, click on “Preset Animation.” To turn
off the effect, choose “Off.” If you wish to change the effect, there are many options to
consider.

To edit content of any slide:

I. Double click on the slide you want to change the content of.

2. Double click on the text box of the slide. A border and white handles appear around
the text box.

3. Type the desired changes.

Remember to save any changes made to your presentation!

www.coastal.com Life Meets Work: Overcoming Stress, Fear and Anxiety Leader’s Guide 4 |5 |


www.coastal.com
www.coastal.com

www.coastal.com Copyright © Coastal Training Technologies Corp. < 16 }

This guide is designed to provide accurate and authoritative information regarding the
subject matter covered. Sources for this information are believed to be reliable. Because
of the possibility of human error, the publisher does not guarantee its accuracy, adequacy
or completeness. Coastal is not responsible for any errors, omissions, misprinting or
ambiguities contained herein or for the results obtained from use of such information. If
legal advice or other expert assistance is required, the services of a competent
professional should be sought.

This leader’s guide is one of a series of print materials, video, interactive CD-ROM,
Web-based and DVD programs produced by Coastal Training Technologies Corporation.
Each product is the result of painstaking analysis, design, development and production by
the instructional designers and technical specialists on our staff.

Our catalog is constantly being revised and expanded, so we would appreciate any
comments on current titles or suggestions for future ones. For further information

on any Coastal product, or to receive a free catalog, call Coastal Training Technologies
Corp. (Virginia Beach, VA) at 800-285-9107 or send a FAX to 757-498-8820. Visit us on
the Web at www.coastal.com.

This guide is for educational purposes only. Nothing herein is to be regarded as indicating
approval or disapproval of any specific practice or product.

Copyright © 2002,2000 Coastal Training Technologies Corp. Purchasers and renters may
copy the Pre-Test, Post-Test, Sample Invitation Memo, Diversity Survey and Evaluation
Form found in the leader’s guide when used in conjunction with the program. Any other
part of this product may not be copied by any means or for any reason without the

written permission of Coastal Training Technologies Corporation. All Rights Reserved.
Printed in U.S.A.
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